
 
 

Copyright 2004-2016 by Foray Page 1 Revised March 30, 2016 
Technologies.  All rights reserved. 

 
 

Latent Print Actions 
 

David Witzke 
Vice President, Program Management 

Foray Technologies 

INTRODUCTION.  This paper was written to provide a detailed summary of the features and 
functions that may be performed using the Latent Prints Actions plug in for Adobe Photoshop.  This plug 
in has been tested/validated for use with Adobe Photoshop CS4, CS5, CS6, and CC (through CC 2015).  In 
addition, the processes used in these macros are standard, approved (SWGIT) techniques, and is designed 
to help ensure compliance with ISO guidelines.  The settings and parameters are also provided in the 
description for each tool.  It should also be noted that the tools and techniques used in these macros are 
non-destructive, meaning that nothing material or essential has been added to or removed from the digital 
image. 

 Latent Print Analysis 

The Latent Print Analysis macro was developed for the purpose of creating a tool (shown below) 
that could be used to document (annotate) the analysis of a single latent impression quickly and 
efficiently.   
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To use this macro, you must start with a calibrated latent impression that has been processed (if 
necessary).  It does not make any difference what the calibrated resolution is of the image as the macro 
is designed to increase the size the image properly.   

Ideally, the image should be cropped to approximately one (1) inch by one (1) inch.  If the 
impression is a partial impression or is significantly smaller than 1” x 1”, you can adjust the image size 
(Image > Image Size) by turning off Resample, and changing the width or height to the desired size.   

NOTE:  When changing one dimension, such as width, the other dimension will also change, so be 
careful not to adjust width if the height is already close to 1” high as the top and/or bottom of the 
impression may be clipped when it is copied to the document mask.  In addition, if you manually change 
the image size before running the macro, please be sure to delete the text layer that contains the 
information regarding percent of magnification. 

ADDING A LOGO.  When the macro starts, it will create a new document window in Adobe 
Photoshop and set up all of the layers required for proper annotation of the image.  The macro will, 
however, pause when it is ready to affix your agency logo.  When the macro pauses, a navigation dialog 
box will appear and allow you to navigate to the location where you keep a copy of your logo for this 
purpose.   

The logo must not exceed a width of 1.15 inches and a height of 1.2 inches, and the resolution of 
the logo file MUST be set to 540 PPI.  Ideally, the logo size should be approximately 1.1” x 1.1” at 540 
PPI.  

When the macro is finished, an image document similar to the one shown above will be displayed 
on your screen, and the image will contain a number of layers as shown on the following page. 
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EDITING TEXT (CASE NUMBER, ETC.).  To edit the text layers, select the Type tool from 
the toolbar on the left side of the Photoshop window.  Place the “I-beam” cursor on top of the X’s or 
the zeros for the date, and double click the left mouse button.  The X’s (or the zeros) will be highlighted 
and you can simply type the correct information.  For purposes of ease of use, there are three text layers: 
one layer for the information at the top of the page, one layer for the examiner’s initials, and one layer 
for the date.  Once the information has been entered for each layer, commit the changes to that layer by 
either clicking the checkmark on the tool options bar, which is located directly beneath the menu bar; 
or by pressing the control key and hitting the Enter key; or by clicking on another layer on the Layers 
panel.   
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MARKING MINUTIAE.  After the text has been entered, click on the Minutia Marking Layer on 
the Layer panel on the right side of the window, then select the Pencil tool from the toolbar (which is a 
function of the Brush (B) tool).  After selecting the Pencil tool, change the size of the pencil to the 
desired size.  (I recommend using a brush size of 30 to 45 pixels for marking minutiae.)  To change the 
size of the pencil, click on the drop down arrow next to the current brush size, then either type the 
number for the desired brush size or slide the slider under the size bar to the desired size.  For visibility, 
the Hardness should always remain at 100%. 

 

 

 

 

 

 

 

The opacity of the dots on the Minutia Marking Layer may be changed so that the underlying ridge 
event being marked is still visible.  First, verify that the appropriate layer (Minutia Marking Layer) is 
highlighted on the Layer panel as shown above.  At the top of the Layer panel, adjust the Opacity by 
either highlighting (double-clicking on) the current value (default value is 100%), typing the desired 
opacity, such as 40 or 50 (percent), and then hitting the Enter key.  The new Opacity value will be 
locked in, and anything added to that layer will be displayed with that level of opacity.   

It is considerably easier to view and mark minutia using two simple techniques.  First, enlarge the 
image on the screen by pressing and holding the Ctrl key and hitting the + (plus) key to zoom in.  (To 
zoom out, press and hold the Ctrl key and hit the – (minus) key.)  Alternatively, you can zoom in and 
out of the image by pressing and holding the Alt key and rolling the mouse wheel forward (to zoom in) 
and backward (to zoom out).  With the cursor on top of the image, press and hold the space bar to turn 
the cursor into the Hand (navigator) tool to move the image around on the screen. 

In addition, use the cursor in “precise” mode, which causes the cursor to appear as a “cross hair” 
cursor thus making it significantly easier to visualize the point where the minutia will be marked. 
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In accordance with SWGFAST Document #8 Standard for the Documentation of Analysis, 
Comparison, Evaluation, and Verification (ACE-V), Ver. 2.0, the color values shown below may be 
used for marking ridge events.  The color used for marking the ridge events may be changed at any 
time simply by clicking on another color value on the Swatches panel located near the top of the window 
on the right side.  (If the Swatches panel is not displayed on the right side of the window, the Swatches 
panel can be turned on by going to the Window menu option, and then highlighting and click on the 
Swatches menu item near the bottom of the menu.) 

 

 

 

 

ERASING MINUTIA.  In the event that a minutia marker is affixed in the wrong (improper) 
location, the “point” can be removed very easily.  If the point was made with the last mouse click, the 
marker can be removed by pressing the Ctrl and Alt keys and typing the letter z (Ctrl + Alt + z).   

If additional ridge events have been marked before discovering that a minutia marker is in the 
wrong location, the marker can be removed using the Eraser tool.  (Type the letter “e” to select the 
Eraser tool on the Photoshop toolbar.)  On the Tool Options bar located directly beneath the menu bar 
at the top of the window, ensure that the Mode for the Eraser tool is set to Block.  Please the cursor 
over the marker to be removed, and click and hold the left mouse button and drag the cursor over the 
marker to erase it.  Then type the letter b to reselect the brush (pencil) tool and continue marking the 
ridge events. 

TRACING RIDGES.  The Latent Print Analysis action also creates a layer upon which ridges can 
be traced to identify ridge flow as well as assist in displaying the ridge counts between different minutia 
points.  Like the Minutia Marking Layer, the transparency (translucence) of the Ridge Tracing Layer 
can be adjusted by changing the Opacity at the top of the Layer panel once the Ridge Tracing Layer 
has been selected.  (Typically, an Opacity of 20-30% works well for tracing ridges; the lines are 
translucent enough that the underlying ridges can be seen through the lines.) 

Also, the Pencil tool is used for tracing the ridges, and the color used for each ridge may be changed 
at any time simply by clicking on another color value on the Swatches panel located near the top of the 
window on the right side.  (Some latent print examiners prefer to use a different color for each tracing 
ridge, which also helps to show the relationship of bifurcating ridges and to distinguish between 
separate ridges.) 

To trace a ridge, position the cursor at a starting point, such as the tip of an ending ridge or a 
bifurcation where the two ridges separate.  As stated earlier, for easier visibility and to ensure a higher 
degree of accuracy when positioning the cursor, ensure the cursor mode is set to “precise” mode by 
enabling the Caps Lock feature.  Then click and release the mouse button, and a dot will appear at the 
starting point.  Press and continue to hold down the Shift key.  (Continue to hold down the Shift key 
until you reach the location where the tracing of that ridge should stop.)  Move the cursor about a 
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quarter of an inch from the starting point, ensuring that the cursor is positioned in the middle of the 
ridge.  Click and release the left mouse button.  A line will be drawn from the first point to the second 
location.  Continue moving the cursor about a quarter of an inch and click and release the mouse button 
to continue the line.  (Where the ridge is straighter, you can move the cursor a longer distance; if the 
ridge is curving, it may be necessary to shorten the distance between mouse clicks.)   

Upon reaching the point where the tracing should stop, release the Shift key.  Then position the 
cursor at the next starting point, click and release the mouse button, press and hold the Shift key, and 
continue moving the cursor along the ridge and clicking the left mouse button to anchor the line along 
the ridge.  Failure to release the Shift key between the ending point for one ridge and the starting point 
of the next ridge will cause a straight line to appear between the two points. 

A completed Latent Print Analysis document might look something like this, depending upon the 
level of detail annotated during the analysis process.  The completed document may be printed and 
saved in the case jacket, and/or it may be saved electronically and saved electronically in accordance 
with the agency’s Standard Operating Procedure.  This document may be used in court to explain how 
the analysis was completed prior to the comparison with possible candidate prints. 
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 Latent Print Comparison 

The Latent Print Comparison macro was developed for the purpose of creating a tool (shown below) 
that could be used to document (annotate) the comparison of a latent impression to a known impression 
quickly and efficiently.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To use this macro, you must start with a latent impression that has been calibrated properly and a 
known impression that has been calibrated properly.  The image size (resolution) does not matter as 
long as the images have been calibrated properly, as the macro is designed to resize the two images 
properly.  In addition, any required image processing of the latent or known impressions must be 
completed and saved before starting this process.   

To ensure the correct image appears in the appropriate frame (latent on the left, known on the right), 
be sure to open the file with the latent print first, and then open the file containing the known impression. 

Ideally, both images should be cropped to approximately one (1) inch by one (1) inch.  If the latent 
impression is a partial impression or is significantly smaller than 1” x 1”, you may want to crop the 
known impression so that only the corresponding areas of the print appear in the document.  You may 
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also adjust the image size (Image > Image Size) by turning off Resample, and changing the width or 
height to the desired size (i.e., approximately 1” x 1”).   

NOTE:  When changing one dimension, such as width, the other dimension will also change; 
therefore, be careful not to adjust width if the height is already close to 1” high as the top and/or bottom 
of the impression may be clipped when it is placed in the masking frame.  In addition, if you manually 
change the image size before running the macro, please be sure to delete the text layer that contains the 
information regarding percent of magnification. 

Please review the instructions provided under the Latent Print Analysis macro as the remaining 
instructions for completing the Latent Print Comparison document are exactly the same. 

Helpful Hint!  Some agencies prefer to use the Latent Print Comparison macro using a latent 
impression and a “blank” known impression.  The reason for using the Latent Print Comparison macro 
with an empty (blank) known image for documenting the analysis process is that the Minutia, Ridge 
Tracing and Area Marking layers can be copied and overlaid on the comparison document when a 
candidate image is available for comparison.  This process eliminates the need to mark the minutia and 
trace ridges twice.  It is imperative that the same latent impression be used for both tasks, especially if 
the latent impression was cropped and/or resized when the analysis was documented. 
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 Latent Palm Print Analysis 

The Latent Palm Print Analysis macro was developed for the purpose of creating a tool (shown 
below) that could be used to document (annotate) the analysis of a latent palm print quickly and 
efficiently.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To use this macro, you must start with a calibrated latent palm impression that has been processed 
(if necessary).  It does not make any difference what the calibrated resolution is of the image as the 
macro is designed to increase the size the image properly.   

Ideally, the image should be cropped to approximately two and three-quarters (2.75) inches by two 
and three-quarters (2.75) inches.  If the impression is a partial impression or is significantly smaller 
than 2.75” x 2.75”, you can adjust the image size (Image > Image Size) by turning off Resample, and 
changing the width or the height to the desired size.   

NOTE:  When changing one dimension, such as width, the other dimension will also change, so be 
careful not to adjust width if the height is already close to 2.75” high as the top and/or bottom of the 
impression may be clipped when it is copied to the document mask.  In addition, if you manually change 
the image size before running the macro, please be sure to delete the text layer that contains the 
information regarding percent of magnification. 

Please review the instructions provided under the Latent Print Analysis macro as the remaining 
instructions for completing the Latent Palm Print Analysis document are exactly the same. 
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 Latent Palm Print Comparison 

The Latent Palm Print Comparison macro was developed for the purpose of creating a tool (shown 
below) that could be used to document (annotate) the comparison of a latent palm print impression to 
a known palm print quickly and efficiently.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To use this macro, you must start with a latent palm print that has been calibrated properly and a 
known palm print that has been calibrated properly.  The image size (resolution) does not matter as 
long as the images have been calibrated properly, as the macro is designed to resize the two images 
properly.  In addition, any required image processing of the palm print impressions must be completed 
and saved before starting this process.   

To ensure the correct image appears in the appropriate frame (latent palm print on the left, known 
palm print on the right), be sure to open the file with the latent palm print first, and then open the file 
containing the known palm print. 

Ideally, both images should be cropped to approximately two and one-half (2.5) inches by two and 
one-half (2.5) inches.  If the latent impression is a partial impression or is significantly smaller than 2” 
x 2”, you may want to crop the known impression so that only the corresponding areas of the print 
appear in the document.  You may also adjust the image size (Image > Image Size) by turning off 
Resample, and changing the width or height to the desired size. 
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NOTE:  When changing one dimension, such as width, the other dimension will also change; 
therefore, be careful not to adjust width if the height is already close to 2.5” high as the top and/or 
bottom of the impression may be clipped when it is placed in the masking frame.  In addition, if you 
manually change the image size before running the macro, please be sure to delete the text layer that 
contains the information regarding percent of magnification. 

Please review the instructions provided under the Latent Print Analysis macro as the remaining 
instructions for completing the Latent Print Comparison document are exactly the same. 

Helpful Hint!  Some agencies prefer to use the Latent Palm Print Comparison macro using a latent 
impression and a “blank” known impression.  The reason for using the Latent Palm Print Comparison 
macro with an empty (blank) known image for documenting the analysis process is that the Minutia, 
Ridge Tracing and Area Marking layers can be copied and overlaid on the comparison document when 
a candidate image is available for comparison.  This process eliminates the need to mark the minutia 
and trace ridges twice.  It is imperative that the same latent impression be used for both tasks, especially 
if the latent impression was cropped and/or resized when the analysis was documented. 
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 Single Image Composite 

Today, commercially available (aka COTS or commercial-off-the-shelf) printers cannot produce 
output with the same high-resolution (image quality) of the image that it represents.  In fact, these 
printers cannot create output at the 1000 PPI resolution required for latent prints being submitted to an 
Automated Fingerprint Identification System (AFIS).  (The 1000 PPI requirement is actually used to 
ensure that all fingerprint images in the system have the same aspect ratio (size).  Moreover, the output 
from a most, if not all, laser printers and dye sublimation printers is limited to ± (plus or minus) 300 
PPI.  Some ink jet printers, such as the Epson SureColor P400 can produce output as high as ± 540 PPI. 

 

 

 

 

Black and white laser printers typically use a 4 dot pitch (4 x 4) grid to produce different shades of 
gray.  Additionally, black and white laser printers also have the ability to place 1200 dots per inch both 
horizontally and vertically.  Dividing the 1200 dots by 4, which is the number of dots used to represent 
the width of a single pixel, yields a quotient of 300, or 300 PPI 

In contrast, ink jet printers use multiple ink colors of varying size droplets placed closely together 
to “trick” the human eye to see a specific pixel color value.  (For best practices, use an ink jet printer 
that has the ability to print a high number of droplets per inch, such as 5760 x 1440.  The printer should 
also have more than the four basic ink colors (Cyan, Magenta, Yellow and Black) to more accurately 
“create” a wider range of color values.  In addition, the ink jet printer should be able to print multiple-
size droplets (such as a droplet size of 1.5 picoliters) to generate the most accurate and reliable output.) 

When digital images are processed by the printer driver, the number of pixels in a high-resolution 
image are downsampled to match the resolution capability of the printer, which means actual pixel 
values are discarded so that the image output will match its life-size dimensions. 

Imagine using two different pieces of drafting paper, where the scale for one page is one square 
inch equals 16 squares (4 x 4 grid), and the scale for the second page is one square inch equals 64 
squares (8 x 8 grid).  Now, assume the squares in the grids are pixels.   
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To duplicate an object from the 8 x 8 grid onto the page with the 4 x 4 grid, the image would have 
to be evaluation using a 2 x 2 grid (4 squares) overlay starting in the upper left corner of the 8 x 8 grid. 
The four (4) values would be averaged together to create a single value that would be placed in the first 
square starting in the upper left corner of the 4 x 4 grid.  That process would be repeated until all of the 
64 original values have been reduced to only 16 values.  The bottom line is that not only are the number 
of original values reduced, but the values used in the lower resolution grid are altered – not “original” 
– values. 

When images are displayed on a monitor, a similar “resampling” process occurs.  However, actual 
pixel values are not discarded when the image is zoomed in or zoomed out for display on a monitor.  In 
fact, you can zoom in to view the individual pixel values.  To mimic the process of zooming when 
printing an image, the physical size of the image must be increased.  Using our earlier analogy, to print 
all 64 values using the 4x4 grid, the physical size of the image would increase from one (1) square inch 
to four (4) square inches.   

To maintain the proper aspect ratio when scaling (enlarging or reducing) the size of an image, the 
resolution must correspond to the resolution of the destination.  For example, to put multiple size images 
onto a single page and ensure they are sized properly, the resolution for each enlargement must 
correspond to the settings used by that device.  For example, using a page size that is 8.5 inches by 11 
inches at 300 PPI, the resolution (image size) for a one-inch by one-inch image copied to that page 
would be changed to 300 PPI.  If the image were to be enlarged and printed two times its actual life 
size, the resolution would be changed to 600 PPI (i.e., the resolution setting used for the page times 2).  
If the image were to be enlarged and printed five times its actual life size, the resolution would be 
changed to 1500 PPI (i.e., the resolution setting used for the page times 5).  If the new page specification 
was 540 PPI, a 1:1 image would have a resolution of 540 PPI; a 2:1 image would have a resolution of 
1080 PPI; a 5:1 image would have a resolution of 2700 PPI. 

In some instances, enlarging an image may require an increase in the number of pixels, creating 
new values based on an averaging technique.  For instance, to enlarge a scanned image with a resolution 
of 1200 PPI to 5 times life size using a laser printer than can only print 300 PPI, the enlarged image 
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would require 1500 pixels (5 x 300), which means that the image would require an additional 300 pixels 
vertically and 300 pixels horizontally for a total of 90,000 new pixel values. 

In summary, the size of a digital image is not based solely on its two dimensional measurements of 
width and height, it includes a third attribute known as resolution.  It is important to know how the 
digital image will be used to ensure that the image capture device has the requisite number of pixels.  
In a digital image, images (from a digital camera) must be calibrated to know the relationship between 
the number of photo receptors on the imaging sensor and the size of the area photographed, which is 
why a scale must be included in every digital image that is captured using a digital camera.  This 
relationship is defined PPI.  For example, to capture a 3-inch x 5-inch lift card with sequential latent 
impressions, the digital camera should have a minimum resolution of 3000 pixels x 5000 pixels (aka 
15,000,000 pixels or 15 megapixels (MP).  An 8.5-inch by 11-inch printout on a laser printer (at 300 
PPI) would require 2,550 pixels vertically and 3,300 pixels horizontally or 8.42 MP.  Therefore, nearly 
44 percent of the pixel values would not be used when printing the lift card enlarged to fill the entire 
page on the laser printer.  If the same lift card were printed on an ink jet printer capable of producing 
an output resolution of 540 PPI, the same 8.5-inch by 11-inch printout would require 4,590 pixels 
vertically by 5,940 pixels horizontally or 27,264,600 pixels or 27.3 MP. 

The Single Image Composite was designed to create a 1:1, life-size image of a calibrated latent 
impression together with a 300 percent (2:1) enlargement and a 500 percent (5:1) enlargement.  The 
page settings are defined for use with a high-quality, ink jet printer (using 540 PPI) with premium photo 
glossy paper.  More specifically, once the image has been calibrated, the user may use the Single Image 
Composite function to create an output similar to the one shown below. 
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The Single Image Composite action begins with the creation of a new page, which is defined as 8 
inches by 10 inches (so that it will fit on either 8 x 10 or 8.5 x 11-inch paper), with a resolution of 540 
PPI, 24-bit color, and with a white background.  The macro then automatically selects the latent image 
file and changes the Resolution (Image Size) to 540 PPI with the Resample option enabled using 
Bicubic (for smooth gradients).   

NOTE:  By enabling the Resample option, the link between the physical size of width and height 
is turned off and the resolution is set to match the destination (the blank page where the image will be 
copied) as a life-size, 1:1 image. 

Once the resampled 1:1 image is copied to the new page, the image size is restored to its original 
calibrated resolution using the step backwards function.  Next, the image size of the latent impression 
is set to 1080 PPI (540 PPI x 2) so that the latent impression will occupy twice the number of pixels as 
the life-size, 1:1 image.  This process also uses twice as many pixels as the 1:1 image, thus providing 
additional clarity of detail. 

After the resampled 2:1 image is copied to the new page, the image size is restored to its original 
calibrated resolution using the step backwards function.  Next, the image size of the latent impression 
is set to 2700 PPI (540 PPI x 5) so that the latent impression will occupy five times the number of pixels 
as the life-size, 1:1 image.  This process also uses twice as many pixels as the 1:1 image, thus providing 
additional clarity of detail. 

After the resampled 5:1 image is copied to the new page, the image size is restored to its original 
calibrated resolution using the step backwards function.   

NOTE:  If the images need to be rearranged on the page, you may either use guidelines that can be 
created by placing the cursor on the ruler on the left or top of the image window, then click and hold 
the left mouse button, and drag a new guideline onto the page.  Alternatively, you can enable a set of 
grid lines by going to the View menu, then Show, and then gridlines.  

Using the move tool, choose either Auto-Select or press and hold the Ctrl key and place the cursor 
on top of the image that you want to move.  Then click and hold the left mouse button and move the 
image to the desired location on the page. 

 Side-by-Side Composite 

The side-by-side composite is based on the technology described in the preceding section entitled, 
“Single Image Composite”.  Using this action (macro), however, both the latent impression and a 
potential “matching” image are placed side-by-side, scaled at 1:1, 2:1 and 5:1.  The purpose of this tool 
is to facilitate an improved technique for image analysis and comparison.  

 5x Side-by-Side Composite 

The 5x Side-by-Side Composite is based on the technology described in the section above entitled, 
“Single Image Composite”.  Using this action (macro), however, both the latent impression and a 
potential “matching” image are placed side-by-side, scaled at 5:1.  The purpose of this tool is to 
facilitate an improved technique for image analysis and comparison.  
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 Basic Ninhydrin Print Processing 

Frequently, latent impressions on porous items (such as paper, checks, money orders, newspaper, 
paper bags, etc.) must be developed using techniques such as ninhydrin, which is a chemical reagent (a 
poisonous crystalline oxidizing agent) used for the detection and analysis of primary and secondary 
amines, such as amino acids that are typically found in fingerprint impressions.  When this chemical 
reagent reacts to the amino acids deposited by the finger, it forms a derivative with a purple (red and 
blue) color value.  When the developed latent impressions are photographed in color, the red and blue 
values that form the color purple (often referred to as magenta), have a different light intensity when 
compared to the background color values.  Therefore, it may be necessary to adjust color values in the 
image to suppress the background colors that interfere with the visualization of the latent impression.  
One technique that is used with some success is to convert the image to Image > Mode > CMYK, and 
then select the Magenta channel.  This technique does not, however, suppress dark (black) backgrounds, 
such as printing, trim and borders on checks or money orders, so on and so forth because black and 
white appear in every color channel for RGB and CMYK modes. 

There are a number of ways in which the ridge detail can be separated from the dark background 
colors so that they do not interfere with the visualization of the latent impression.  These techniques are 
based on the difference of light intensity (of pixels) between the purple ridge detail and the black 
background.   

Please note that not all capture processes work the same.  Using a flatbed scanner, there is only one 
light intensity that strikes the surface of the object on the scanner.  As a result, the light intensity for 
the pixels in the various color channels (Red, Green and Blue, or Cyan, Magenta, Yellow and Black) 
are very similar, and cannot be separated easily and must be processed using a different technique. 

 Nin Cal CD SH 

Nin Cal LD SH is short for Ninhydrin (prints digitally processed using) Calculations (blending 
algorithm known as) Color Dodge (and the tonal range, brightness and contrast adjusted using) 
Shadows/Highlights. 

Each red, green and blue pixel value in a digital image has a brightness (intensity) value that is 
unique in each color channel. The Calculations function in Adobe Photoshop allows you to use the 
different brightness values for each pixel to produce a composite value for each pixel. This means you 
can neutralize background noise by blending one channel intensity for a pixel (such as the brightness 
value of a pixel in the Red channel) with the Channel intensity (such as the brightness value of the exact 
same pixel in the Green channel) to suppress background noise. 

The illustration shown below illustrates the difference in brightness values for a ninhydrin print on 
a check. The image appearing in the upper left shows the original image in RGB color. The image in 
the upper right shows the image filtered with the Red channel; the image in the lower left shows the 
image filtered with the Green channel; and the image in the lower right shows the same image filtered 
with the Blue channel. 
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The appearance of fingerprint ridge detail is less visible in the Red channel while they appear darker 
in the Green channel.  In addition, the intensity of the check border in the Red channel is almost identical 
to the intensity of the border in the Green channel.  In the Blue channel, the ridge detail blends into the 
background and the border also appears to be a lighter shade of gray.  In addition, there is more 
background noise in the Blue channel than in either the Red channel or the Green channel. 

Due to the similarity of the background in the Red and Green channels, and the ridge detail is more 
visible in the Green channel, it is possible to subtract the values of the Red from the Green channel 
using an algorithm that simulates mathematical equations or Calculations.  However, there is more to 
the process than simple subtraction. For example, we do not want to subtract the subtle ridge values in 
channel Red from channel Green because the ridge detail is already a light grayscale value and the 
contrast will have to be increased.   

Using Calculations, the Red channel is selected as source 1 because of the limited amount of ridge 
detail visible in this channel.  In addition, source 1 is inverted.  The Green channel is selected as source 2 
because the background is nearly identical to the background in source 1, and the Green channel 
contains the highest level of visible ridge detail.  The algorithm color dodge is selected to suppress the 
background noise (i.e., letters, border, line, etc.). 

The Color Dodge algorithm (i.e., the mathematical calculation used for the pixel values) compares 
the pixel value in source 2 to each pixel’s corresponding value in the inverted source 1.  More 
specifically, when the dark values of the border pixels in the Red channel as shown below are inverted, 
they appear as a lighter shade of gray.  In the case of a latent impression, the ridge detail is practically 
non-existent on the Red channel, so the pixel values for the background and whatever ridge detail is 
present is inverted from white to black on the histogram.  And, since the Color Dodge function only 
reduces source 2 pixel values that are on the left side of the histogram, the ridge details and background 
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in the green channel are lighter shades of gray (on the white / right side of the histogram), so no action 
occurs because the corresponding pixel values for that area on the Red channel are all on the dark (left) 
side of the histogram. 

 

 

 

 

 

 

 

 

 

 

 

 

When the brightness (intensity) values of the two channels are processed, the results are displayed 
in a new “Alpha” channel, which is also referred to as a multi-channel value because it consists of the 
processed brightness pixel values from two channels: Source 1 and Source 2.  The new alpha channel 
appears on the color Channels palette in addition to the Red, Green and Blue color channels.  

Any time a new Alpha channel is created in a digital image, the Alpha channel must be converted 
to grayscale because other applications do not recognize multi-channel values; if the image is saved 
with RGB channels and the Alpha channel, the image will appear as the RGB image outside Adobe 
Photoshop, and the processed results will not be visible.  To fix this problem, select the Alpha channel 
and convert the image to Mode > Grayscale. 

After the background has been suppressed and the alpha channel has been converted to grayscale, 
the next step is to perform a basic contrast adjustment.  In this action, the brightness and contrast values 
are adjusted automatically using the Shadows/Highlights feature.   

Shadows and Highlights was first introduced in Adobe Photoshop CS, which was released in 
October 2003.  Before this tool became available, Levels was the most commonly accepted method for 
adjusting contrast in digital images. 

The Shadows/Highlights command provides greater control when adjusting contrast.  Using this 
tool, the adjustment of pixel values can be limited to a very specific range of values in both the shadows 
and/or highlights.  In other words, the contrast can be adjusted for pixels in the Shadows range without 
affecting the values of pixels in the Highlights range and vice versa.  Also, one range of pixel values 
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can be adjusted without affecting all of the other pixel values in the image, which is a vast improvement 
over the use of Levels.   

 Nin Cal LD SH 

Nin Cal LD SH is short for Ninhydrin (prints digitally processed using) Calculations (blending 
algorithm known as) Linear Dodge (and the tonal range, brightness and contrast adjusted using) 
Shadows/Highlights. 

The Linear Dodge blending technique works in much the same was as Color Dodge.  However, 
with Linear Dodge, the dark values are suppressed even more than in Color Dodge, which is sometimes 
required because of the background contrast.  Typically in this case, the Opacity must also be adjusted 
because the additional background suppression makes it appear as though the image were overexposed 
in those areas where the black background has been suppressed.  By adjusting opacity, you can adjust 
the exposure for these overly suppressed (over exposed) areas. 

The rest of the functions are identical between the actions Nin Cal CD SH and Nin Cal LD SH, 

 Nin Lab A 

While the Calculations feature is very useful, this process does not work in all instances as it 
depends on the intensity values for two channels in the image.  This process does not typically work 
well for digital images captured using a flatbed scanner because the intensity (brightness) value for 
pixels in the Red channel and Green channel are too similar.  (Flatbed scanners have only one light 
source, so the same light intensity is used for capturing red, green and blue pixel values.  Similarly, 
images photographed digitally using an alternate light source have brightness values that are far too 
similar in all color channels. 

In addition, all digital cameras (except those digital SLR cameras that use a Foveon imaging sensor) 
have a color filter array (CFA) consisting of red, green, and blue filters overlaying the imaging sensor 
in the camera. In most, if not all, instances, the CFA consists of 50% green filters, 25% red filters, and 
25% blue filters.  The camera (or the computer in the case of a RAW image) calculates pixel color 
values using a demosaicing algorithm commonly referred to as a Bayer pattern that creates the color 
values using the brightness values and color filtered pixel value from the neighboring photo sensors. 

In this action for ninhydrin-developed prints and/or chemically processed impressions, the image 
is converted from RGB to Mode > Lab Color.  Then channel a, which displays the chromatic (color) 
values of all pixels using only the green and red CFA values, is selected; and the image is converted to 
grayscale.  

Since the luminance values [Lightness channel] are separated from the Chrominance values 
[Channels a and b], Levels is the only process that can be used to spread the Chrominance (midtone) 
values across the full width of the histogram and thus create contrast between the values.)  In this action, 
the levels are set to auto to balance the contrast within the image. 
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 Red Filter 

In digital imaging, all color values are based upon the use of Red, Green, and Blue color values.  
All digital camera, flatbed scanners, video cameras, televisions and computer monitors use these RGB 
values to create a wide range of color values.  In fact, using 8-bits per color channel (aka 24-bit color), 
a total of 16,777,216 different color values can be created (256 x 256 x 256).   

Color channels are used in Adobe Photoshop in much the same way as what color filters were 
applied to a lens when doing conventional, black and white photography.  Frequently, people often 
misstate that red subtracts the red values from the image.  This is a not only a misstatement, but it is 
technologically wrong.   

When a color channel is selected, color values within that color family are passed as a light gradient.  
For example, when the red color channel is selected, the pure red values are passed as a white value, 
where the overlapping values of magenta are passed as lighter shades or lighter gradient values based 
upon how much red is used in the magenta color values.  In addition, the overlapping values of yellow 
are also passed as lighter shades or lighter gradient values based upon how much red is used in the 
yellow color values. 

When the red color channel is selected, the green and blue color values are passed as darker 
gradients.  In some cases, the selected color channel balances the contrast of the background colors so 
that there is less contrast (fewer shades of gray), thus providing a more consistent background color. 

 

 

 

 

 

 

 

 

 

 

Using this action, the Red color channel is selected to suppress the visualization of color values 
that are within the Red color family.  Color values that are within the Blue and Green color families are 
converted to a grayscale gradient based upon the intensity of the individual pixel values.  The result is 
an RGB image that appears as a grayscale image, which must be converted to Image > Mode > 
Grayscale.   

Once the image is converted to grayscale, the Shadows/Highlights feature is applied to balance 
tonal range and contrast. 
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In the image below, the original image appears on the left, and Red color channel was selected in 
the image on the right.  As you can see, the background is more consistent.  In the image below, the 
Blue channel would have made the blue background and the cyan (lighter blue values) a white or lighter 
grayscale value.  Since the print was developed using cyanoacrylate fuming, the ridge detail appears as 
a light grayscale value, which would blend in with the ridge detail, making it extremely difficult if not 
impossible to distinguish the background from the ridge detail.  Selecting the green channel would have 
also made the cyan color values appear as a lighter shade of gray, again making it a challenge to 
distinguish between the ridge detail and the background.  In the image appearing on the right, the red 
color channel was selected, thus making the background a consistent dark value, which is easy to 
distinguish between the white ridge detail and the background. 

 

 

 

 

 

 

 

 

 

 

And, of course, the final image is converted to grayscale and the Shadows/Highlights feature is 
applied to balance tonal range and contrast of the image. 

 Red Filter Invert 

This action performs the exact same functions as described above for the Red Filter.  One additional 
step is performed with this action.  After the image is converted to grayscale, the image is inverted so 
that what is on the light side of the histogram is on the dark side of the histogram, and what was on the 
dark side of the histogram previously is now on the light side of the histogram.   

The image appearing below illustrates the next step in processing the image above so that the white 
ridges that were developed by the cyanoacrylate process appear as a dark gradient and the background 
appears as a light gradient.  
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And, of course, the final image is converted to grayscale and the Shadows/Highlights feature is 
applied to balance tonal range and contrast of the image. 

 Green Filter 

The Green Filter action performs the exact same function as described above for the Red Filter, 
except that the green color values are passed as a light shade of gray while the red and blue color values 
are passed as darker shades of gray.  This technique was frequently used for enhancing latent prints 
developed using ninhydrin as the green channel also isolates just the red and blue value (which are 
combined to make purple or magenta).  Another good use of this action is when images have been 
captured using a Ruvis system, in which the ridges appear as a brighter shade of green. 

And, of course, the final image is converted to grayscale and the Shadows/Highlights feature is 
applied to balance tonal range and contrast of the image. 

 Green Filter Invert 

The Green Filter Invert action performs the exact same function as described above for the Red 
Filter Invert, except that the green color values are passed as a light shade of gray while the red and 
blue color values are passed as darker shades of gray.  This technique is often used when images have 
been captured using a Ruvis system, in which the ridges appear as a brighter shade of green, and the 
examiner wants the ridges to appear dark and the background to appear lighter. 

The final image is converted to grayscale and the Shadows/Highlights feature is applied to balance 
tonal range and contrast of the image. 

 Blue Filter 

The Blue Filter action performs the exact same function as described above for the Red Filter, 
except that the blue color values are passed as a light shade of gray while the red and green color values 
are passed as darker shades of gray.   
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The final image is converted to grayscale and the Shadows/Highlights feature is applied to balance 
tonal range and contrast of the image. 

 Blue Filter Invert 

The Blue Filter Invert action performs the exact same function as described above for the Red Filter 
Invert, except that the blue color values are passed as a light shade of gray while the red and green color 
values are passed as darker shades of gray.   

The final image is converted to grayscale and the Shadows/Highlights feature is applied to balance 
tonal range and contrast of the image. 

 No Filter Auto Contrast 

The No Filter Auto Contrast action converts the image to grayscale and applies the 
Shadows/Highlights process to balance tonal range and contrast of the image.  This action is typically 
used when lift cards have been photographed or scanned, but the original object was a grayscale image. 

 No Filter Auto Contrast Invert 

The No Filter Auto Contrast Invert action converts the image to grayscale, applies the Shadows/ 
Highlights process to balance tonal range and contrast of the image, and then inverts the image.  This 
action is typically used when black lift cards with white powder lifts have been photographed or 
scanned, but the original object was a grayscale image. 
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